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 1. Introduction 
 
This course covers the use of the Field System tasks onoff and gnplt for antenna gain calibration. 
Instruction will be given on the preparation and execution of onoff for the automatic acquisition of 
amplitude calibration data. Attendees will learn about the necessary procedure files, methods of 
measuring noise diode temperature and gain curves and the interpretation of the resulting log files. 
The second half of the course provides training on the use of gnplt for the analysis of calibration 
data. Much of the theoretical background for this course can be found in the seminar notes for 
Pointing and Single Dish Amplitude Calibration Theory. 
 
2. What are we trying to do? 
 
In the seminar Pointing and Single Dish Amplitude Calibration Theory it was shown how absolute 
calibration of both antenna gain and system temperature can be made and then combined to estimate 
the SEFD in Jy. This is the relevant quantity for amplitude calibration.  
 
A convenient way of collecting gain calibration data is to use the Field System program called aquir. 
This program cycles around a supplied list of calibrator sources, making observations of all those 
above the horizon. For each source, it first optionally executes the fivpt task that makes a series of 
observations around the nominal pointing position and fits for the position offset giving maximum 
power. In order to get accurate gain elevation information it is essential to have an accurate pointing 
model. Such data can also be used to update the pointing model used for observations. However, a 
separate maintenance workshop, Automated Pointing Models Using the FS, will address the issue of 
fivpt operation. Following fivpt, the aquir program runs the onoff task for each source to 
determine the power ratio in the equation  
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where G is the antenna gain, Tcal is the cal diode temperature, S is the source flux, Pon-source and Poff-source 
are the power levels on and off source respectively (with the noise diode switched off) and Pcal-on and 
Pcal-off are the power levels off source with the noise diode switched on and off respectively. Combined 
with estimates of the flux densities of the calibrator sources and Tcal, this program can be used to 
collect a large database of antenna gain values allowing us to fit for the gain curve g and the DPFU.  
 
The system temperature Tcal, divided by the net antenna gain G in KJy-1 can be considered the cal 
diode strength in Janskies, or TcalJy. Unlike Tcal, TcalJy depends on elevation because the antenna gain 
curve g is elevation dependent. Direct measurements of this TcalJy are made by the onoff task 
automatically by comparing the power levels obtained by switching the cal diode on and off with the 
change by going on and off a source of known flux density.  
 
To calibrate an antenna, onoff measurements should be performed regularly. A new set of TcalJy 
measurements are checked to see if they are consistent with the adopted Tcal, gain polynomial g and 
DPFU. If they are not, the adopted parameters are changed by analysing the onoff results with 
gnplt. The use of gnplt is dealt with in the second part of this Maintenance Workshop. If just the 
scaling of the predicted TcalJy versus elevation is wrong but the shape is right, we can simply change 
the adopted Tcal or DPFU until it fits. If it is the shape that doesn’t fit, then the antenna gain curve g 
must be refitted. Once the combination of Tcal, gain curve and DPFU that best matches the data are 
found, these values can be adopted to derive Tsys information for actual observations. This process is 
described in the seminar Generating ANTAB Tsys Files. The following notes give details on preparing 
and running the onoff task.  
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3. Setting up a calibration 
 
There are several preliminary steps required before running the onoff program. These are detailed 
below. For more information, the Field System help file for onoff is shown in Appendix 1. 
 
a). Provide an initial ‘rxg’ file 
 
The Field System requires a file that details the current receiver parameters and calibration data for 
the telescope/receiver system in use. These files have the ‘rxg’ extension and are kept in the directory 
/us2/fs/control/rxg_files. An example ‘rxg’ file for the Lovell 76m telescope at Jodrell Bank Observatory 
is shown in Appendix 2. This example is for L-band (18cm) observations. If you do not have a 
previously defined ‘rxg’ file, several default files are available in the appropriate directory. Edit one of 
these to contain the relevant parameters for telescope/receiver combination. The Field System 
decides which ‘rxg’ file to use based on the effective LO setting within the file so ensure that these 
settings agree with the effective LO issued by your LO command in the Field System. 
 
Several astronomical stations operate several telescopes and it is also not uncommon for different 
receivers/noise diodes to be used at different times. Hence, several files with the same LO setting may 
be required at your station and these should be held in a separate directory. Copy the relevant file to 
the rxg_files directory before running onoff. This process may eventually be automated with an FS 
script. It is also advisable to keep backup copies of all ‘rxg’ files since this provides an accurate record 
of the calibration parameters used at any time at your station. In fact, the gnplt program, which will 
ultimately be used to update the ‘rxg’ file, retains previous data as commented lines at the bottom of 
the ‘rxg’ files, but users may also wish to keep the files separately for ease of access. 
 
Familiarise yourself with the format of the ‘rxg’ file. Make sure the LO, date, beamwidth format, 
available polarisations, DPFUs, gain polynomial, Tcal versus frequency, antenna temperature Trec and 
spill-over table are appropriate. If you do not have values of the Tcal versus frequency, estimate a 
single value and duplicate this value over perhaps ten frequency points across the entire receiver 
bandwidth. It is important that the range of frequencies in the ‘rxg’ file is equal to or greater than the 
range of frequencies over which you will be setting the video converters (VCs) or BBCs. 
 
b). Edit the acquir.prc file  
 
The aquir program uses the acquir.prc procedure file held in the usual procedure directory of the 
FS. An example of some of the important procedures within this file can be found in Appendix 3. Edit 
this file before running onoff. Firstly, ensure the calonnf and caloffnf procedures exist in the 
acquir.prc file according to the instructions in the onoff help file (Appendix 1). Next, edit the 
initp procedure to setup the parameters for onoff. In the example the relevant line is, 
 
onoff=2,2,60,3.0,1200,allvc 
 
This performs 2 repetitions with a 2 second integration time, performs elevation-only offsets above 60 
degrees elevation, steps 3 beamwidths off source for off-source measurements, allows 1200 seconds 
for the process to return its status and uses all VCs. Generally, IF channels should not be used for Tcal 
against frequency determination since their frequency is not properly specified. IF channels can be 
used for gain-elevation determination and for fivpt. Also note that you should not use both the LSB 
and USB of a single VLBA BBC at the same time, as this creates problems for analysis. Note that the 
fivpt command for aquir is also defined here but this is covered in the maintenance workshop 
Automated Pointing Models Using the FS.  
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Next, ensure the acquire procedure points to the control file you want to use for these 
measurements (see section d. below) and that the log filename is set for the Field System. In the 
example the relevant lines are, 
 
sy=run aquir /usr2/control/ctlpo.ctl $ & 
log=acquir 
 
Also, ensure the ‘rxg’ filename and the LO settings agree with those in your ‘rxg’ file as given in the 
calrx command. In the example the relevant line is, 
 
calrx=calrx,fixed,1510.0,1510.0 
 
Finally, it is helpful to be able to include all relevant telescope/receiver parameters in the acquire log 
file. This can be achieved by adding a procedure to the station library (called logpar in the example 
acquir.prc file) which logs your telescope/receiver setup (e.g. local synthesiser values, band 
switches, carousel positions etc). In the example, the logpar command is issued in the acquire 
procedure. 
 
c). Edit the ctlpo.ctl file 
 
In the above example, we told the aquir program to use the control file ctlpo.ctl. An example of 
such a file is found in Appendix 4. This file lists the calibration sources around which the aquir 
program should cycle. For each, aquir will perform those tasks selected in the line for each source. 
In the example file, only one source is selected (uncommented), thus,  
 
3c286      132849.66 +304558.7 1950 PREP    -2 -2 5 0 POSTP    10 
 
This line instructs aquir to run the onoff task only on target 3c286, to wait 5 minutes for onoff to 
complete, run the postp procedure on completion (held in the acquir.prc file) and then wait 10 
minutes before repeating the cycle. For full details of what each parameter means, see the 
descriptions in the example ctlpo.ctl file. In this file, you can select any number of sources to use 
by un-commenting them. They can be in any order you choose and can be duplicated if desired. 
Generally, if you are interested only in Tcal measurements, a number of sources should be used at 
reasonable elevation, for pointing measurements different sources at all elevations and azimuths 
should be tracked, and for gain curve determination a single source at a time should be followed for its 
full elevation range until a complete 0-90 degree set of measurements are recorded.  
 
Note that the ctlpo.ctl file also contains details of the elevation limits and elevation mask for your 
telescope. If you are doing the gain curve then you may want to start at low elevation to pull the curve 
down, so make sure these numbers allow you to run aquir at low elevations (as low as 2 degrees). 
 
An additional file that is required for aquir to run is the file containing details of the source flux 
densities so that onoff can deduce the expected power levels at each frequency. This file is held in 
the usual control directory and is called flux.ctl. It is unlikely you will ever have to look at this file 
but for completeness a copy is shown in Appendix 6.  
 
d). Edit your setup procedure to select LOs and devices etc. 
 
In the setup command for onoff detailed in section b. above, we requested use of all VCs for the 
determination of calibration data. Generally, we would set the VCs up to cover as wide a band as 
possible across the receiver band in order to determine the Tcal versus frequency dependence. Often, 
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if we are primarily concerned with the Tcal versus frequency dependence, we can run separate 
instances of aquir to measure the different, narrower subbands of the receiver band and hence build 
up a fine grid of points for fitting. To do this, aquir can be stopped using the kill command, the VC 
settings changed, and aquir restarted. If doing this, there is no need to select a new aquir log file 
since the additional data will be added to the old and gnplt will take care of extracting it. We only 
need to change log file if we change effective LO, receiver, noise diode or telescope.  
 
In practice, it is convenient to set up a number of procedures in the station library, which quickly define 
the VC frequencies and other parameters we want to use for each band at which we operate. An 
example of such a set up procedure can be found in Appendix 5 for the Lovell 76m telescope 
operating at 5GHz (C-band) in dual polarisation mode. Note that many of the commands in this 
procedure library are station specific since they are setting synthesiser values and band switches etc. 
Importantly, the LO command issued in this procedure library should agree with those found in the 
acquir.prc file and the ‘rxg’ file, although in the examples given in these notes, they do not agree! 
Note also that patch commands etc. are also provided, as this is a requirement of onoff. You can 
either edit a single procedure each time you run aquir or provide different setups for different 
telescopes/receivers/frequencies.  
 
4. Running the Calibration 
 
After setting up for onoff, it is a very simple task to gather the required data. The following assumes 
that the telescope is operational, that pointing offsets have been measured and set, the telescope 
focus is correct and the IF attenuators are appropriately set. For example, we need only run a local 
setup procedure (Appendix 5), select the acquir.prc procedure file and run acquire; 
 
> c5gdp 
> proc=acquir 
> acquire 
 
The data acquisition can be stopped by issuing the kill command at any time. As usual, the FS 
reports the output of aquir to the terminal as well as to the acquire log file. Understanding this log 
file is not essential since gnplt extracts and displays the essential information used in the calibration. 
However, some basic details are given below.  
 
An example log file from aquir is shown in Appendix 7. This shows a single measurement cycle on 
the calibrator 3c161 using the Lovell 76m telescope at L-band (1.6 GHz, 18 cm). Once started, aquir 
reports the telescope/receiver setup using the local procedure logpar. After arriving on source, 
onoff reports the current gain information for each selected VC derived from the current ‘rxg’ file that 
it found matching the defined LO command. These lines, one for each detector, are of the form; 
 
2004.047.16:34:52.29#onoff#APR 1u   1631.99 9.000    16.7  1.200000 0.83418  1.001014 1510.00 c 0.16896 

 
and list the central frequency, currently defined Tcal (may be interpolated from the values in the ‘rxg’ 
file), the expected flux from the target, the DPFU, the gain at this elevation, the product of DPFU and 
gain, the effective LO and the beamsize (FWHM) for this detector. There next follows a series of lines 
of the form; 
 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 1u   6531.5      2.1 2u   3563.0      2.8 

 
which give the elapsed time in seconds, the azimuth and elevation offsets, a detector, its counts and 
the corresponding error (and the same for a second detector). The ONSO, ONSC, OFFC and OFFS 
codes signify whether the measurement is on or off source with the cal diode on or off and ZERO 
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signifies measurements with full attenuation (zero level). onoff proceeds to measure values on either 
side of the target before summarising the results in SIG lines. The final result for this measurement is 
listed in VAL lines, in the example below, as follows; 
 
 
2004.047.16:36:58.46#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 1u 1 l   1631.99 0.9457 43.76   43.0   8.852 0.9846 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 2u 2 r   1631.99 0.9626 49.33   41.8   8.476 0.8485 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 3u 1 l   1641.99 0.9879 64.12   46.6   6.534 0.7268 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 4u 2 r   1641.99 0.8385 60.81   59.7   9.812 0.9822 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 5u 1 l   1651.99 0.9573 53.11   45.7   7.752 0.8622 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 6u 2 r   1651.99 0.9589 59.21   44.0   7.438 0.7445 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 7u 1 l   1661.99 0.9562 42.96   42.9   8.991 1.0000 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 8u 2 r   1661.99 0.9626 42.58   42.3   9.927 0.9937 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 9u 1 l   1671.99 0.8551 63.28   41.3   5.873 0.6532 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 au 2 r   1671.99 0.9043 74.32   39.6   5.334 0.5339 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 bu 1 l   1681.99 0.9541 60.67   42.0   6.233 0.6932 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 cu 2 r   1681.99 0.9616 68.51   41.1   6.004 0.6010 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 du 1 l   1691.99 0.9123 35.95   44.5  11.134 1.2383 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 eu 2 r   1691.99 1.0626 63.88   51.4   8.051 0.8059 

 
This table shows the crucial results. For each detector, it shows the azimuth and elevation, detector 
name, IF channel, polarisation, central frequency, gain compression, Tsys, SEFD, TcalJy and the ratio of 
the adopted to the measured Tcal, called Tcal(r). There are obvious things to check in these results. 
Firstly, the measured Tsys values should be close to what you expect for this telescope/receiver 
combination. Secondly, if the current calibration information (found in the current ‘rxg’ file) is accurate, 
the final column of numbers should all be close to unity. If some are not, there may be reasons other 
than bad calibration (for example, saturation or extreme RFI). If all these numbers are not close to 1.0 
the calibration is almost certainly wrong. Analysis of the data can then be achieved using gnplt to 
formulate an updated ‘rxg’ file, which better represents the combination of DPFU, gain curve and Tcal 
versus frequency.  
 
The operational procedures that stations follow in order to acquire accurate calibration data is 
dependent on local constraints. Amplitude calibration for astronomical observations is of paramount 
importance because it enables a calibration of the correlated amplitudes leading to more reliable 
scientific results.  
 
Within the EVN, for example, which observes 3 or 4 times per year, typically for 3 week intensive 
periods, calibration experiments are part of the agreed schedule of observations. Within these 
reserved periods, telescope operators are free to pursue whatever regime is necessary to provide 
accurate calibration data. With typically 3 or 4 observing bands per session, this involves a 
considerable work load. Hence, gain curves are generally not measured more than once per year, 
although these must always be re-measured if changes are made to the telescope structure. Many 
EVN stations do, however, manage to provide updated gain curves for each EVN observing session. It 
is important to remember that gain-elevation and Tcal against frequency analyses should ideally by 
done in two separate observing runs, since the results are interdependent. Checking the Tcal values 
across each observing band in use is now a routine part of EVN operations and these results are 
filtered through to the users by combining them with measurements taken during actual scientific 
experiments. How this is achieved is detailed in the seminar Generating ANTAB Tsys Files. 
 
The choice of calibration source is important. For 25m antennas up to about 5GHz, Cygnus A is a 
good target source. For larger antennas or higher frequencies, experimentation to identify suitable 
calibrators from the flux.ctl file is advisable.  
 
Another source of confusing results is the incorrect use of local antenna control software by acquir 
or onoff. For example, if the local control software reports an ‘onsource’ condition before the antenna 
has settled, the calibration results will be meaningless.  
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Appendix 1: ONOFF help file 
 
                     onoff - on-off radiometry 
 
            Syntax:     onoff=rep,intp,cutoff,stp,wait,devices 
 
            Response:   onoff/rep,intp,cutoff,stp,wait,ssize,mfwhm 
                onoff/device,if,pol,fwhm,center,flux,dpfu,gain,product 
 
 
Settable parameters: 
    rep       Number of repetitions, 1 to 99. Default is 2.  
    intp      Integration period, 1 to 10 seconds. Default is 1.  
    cutoff    Elevation above which to step in elevation rather than azimuth,            
   in degrees, default 75. 
    stp       Distance off source for off source and calibration 
              points, in multiples of a beamwidth. Default is 3.0. 
    wait      Seconds to wait for onsource for each point, 1-1200 
              seconds allowed, default 120. 
    devices   One or more of all standard device mnemonics, plus 
              all, allvc, formvc, and formif  for Mark III/IV, plus allbbc,       
    allu, alll, formbbc, and formif for VLBA/4. For all racks station defined 
   detectors u5 and u6 are supported if the station has them implemented. 
 
Monitor-only parameters: 
    ssize     source size, degrees 
    mfwhm     maximum full-width-half-maximum of all selected devices, degrees 
    device    a selected device's mnemonic  
    if        if chain for device, 1-3 for Mark III/IV and LBA4, a-d for VLBA/4 
    pol       polarization for device, l for left and r for right 
    fwhm      full-width-half-maximum for device, degrees 
    center    center frequency for device, MHz 
    tcal      Noise diode temperature for center, degrees K 
    flux      Source flux for center, Janskys 
    corr      Source flux correction for center and fwhm, dimensionless 
    dpfu      Degrees-per-Flux-Unit, for band of device, in degrees/Janskys 
    gain      gain curve value for band of device at current elevation, dimensionless 
    product   dpfu*gain for device, degrees/Janskys 
 
Comments: 
This version works only with Mark III/IV or VLBA/4 devices, i.e. user defined devices are 
not supported. 
 
The parameters should be setup by issuing a onoff=... command. A measurement is started by 
issuing a simple onoff. This will recover the current values for the display only parameters 
and schedule an external program onoff. See the onoff manual in Volume 2 (currently out-of-
date). 
 
The current command antenna position including offsets is assumed to be 'onsource.' 
  
It is recommended that nothing else be done, e.g. running a schedule, while this command is 
executing. Since this command may run for an extended period of time, a mechanism has been 
supplied for aborting: enter sy=brk onoff & as a SNAP command. After aborting, the offsets 
will be returned to their original values. 
 
In order for this command to work, the following conditions must be met: (1) the detector 
devices have been set up by the Field System, (2) the appropriate lo=  commands have been 
issued, (3) for a Mark III/IV or LBA4 rack only, the IF distributors have been set up by the 
Field System and must be in remote, (4) for a Mark III/IV or LBA4 rack only, if a video 
converter is used as a detector, the appropriate patch= command must have been issued, and 
(5) for a VLBA/4 rack only, if a BBC is used as a detector, the appropriate BBC IF input 
must be selected with a bbcXX= command. 
 
If a noise diode temperature is less than zero, it is assumed that there is no noise diode 
to use for that detector. All measurements for that channel will be made assuming the 
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absolute value of the diode temperature is the system temperature. Thus if the noise diode 
temperature is -100, the power measurements will come out as a percentage of the system 
temperature. Other quantities dependent on the noise diode will be displayed as 0.0. 
 
If either noise diode temperature is greater than zero, then two procedures must be 
available: calonnf and caloffnf, which are used to turn the noise diode on and off 
respectively. The recommended form for these procedures is: 
 
CALONNF:  calon 
          !+1s 
          sy=go onoff &  
 
CALOFFNF: caloff 
          !+1s 
          sy=go onoff &  
 
calon and caloff are local procedures that do whatever is necessary to turn the noise source 
on and off, respectively.  
 
If station dependent detectors u5 and/or u6 are used, two additional procedures must be 
available to turn the signal on and off to the detectors. The recommended form of this 
procedures is: 
 
SIGONNF:  sigon 
          !+1s  
          sy=go onoff & 
 
SIGOFFNF: sigoff 
          !+1s  
          sy=go onoff & 
 
sigon and sigoff are local procedures that do whatever is necessary to turn the signal to 
the station dependent detectors on and off, respectively. 
 
The "formbbc", "formif", and "formvc" detector device parameters will cause the BBCs, IFs, 
or VCs (respectively) that are current defined for recording by the formatter to be selected 
as detectors. This is useful for checking SEFDs in all channels to be used in an experiment. 
 
There is a known bug in the use of these procedures: calonnf, caloffnf, sigonnf, and 
sigoffnf, that may require the last two lines to be repeated in each procedure. In other 
words after the first line, each procedure should contain: 
 
          !+1s 
          sy=go onoff & 
          !+1s 
          sy=go onoff & 
 
The indication that this is needed is if onoff seems to hang after executing one of these 
procedures. Please see the "Known Bugs" section of the latest update notice for more 
details. 
 
The default wait time for of 120 seconds is generous, but can be adjusted if necessary. 
Slower antennas may need a longer time. Shorter times are only useful to make onoff give-up 
sooner if there is a problem getting on-source. 
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Appendix 2: Example ‘rxg’ file for Lovell 76m telescope at L-band 
 
* calrx.rxg - L band receiver parameter definition for Jodrell Bank Lovell telescope 
* 
* first line: LO values and ranges, format: 
*  type   frequencies 
* if type is range, the two values: lower and upper frequencies 
* if type is fixed, then one or two fixed value 
* frequencies in MHz 
* 
fixed 1510 1510 
* 
* 2nd line: creation date 
* format:  yyyy ddd or yyyy mm dd (0 is valid for all for intial set-up) 
* 
2005 03 01 
* 
* 3rd line: FWHM beamwidthm format: 
*   model value 
* 
* if type is frequncy, then fwhm=value*1.22*c/(freq*diameter) 
*                      value is 1.0 if omitted 
* if type is constant, then fwhm=value (degrees) 
* 
frequency 1.0 
* 
* 4th line polarizations available 
* 
* one of both of lcp and rcp 
* 
lcp rcp 
* 
* 5th line: DPFU (degrees/Jansky) for polarizations in previous line in order 
* 
1.183967 1.1823 
* 
* 6th line: gain curve (only one) for ALL polarizations in 4th line 
* TYPE FORM COEFFICENTS ... 
* 
* FORM = POLY only for now 
* TYPE - ELEV and ALTAZ only for now 
* COEFFICENTS - variable number of number values 
* 
* maximum coefficents 10 
* 
ELEV POLY 0.75147458 0.0085738926 4.4339e-05 -4.5298173e-06 5.4629099e-08 -2.1277245e-10 
* 
* 7th and following lines: tcal versus frequency 
*     Format: POL FREQ TCAL 
*     where: 
*            POL    polarization rcp or lcp 
*            FREQ   frequency (MHz) 
*            TCAL   degrees K 
* 
*     MAXIMUM ENTRIES 100, group by polarization 
*                          then sorted by increasing freq 
* 
lcp 1632.0 6.8312 
lcp 1642.0 6.1360 
lcp 1652.0 7.9144 
lcp 1662.0 9.4616 
lcp 1682.0 6.0362 
lcp 1692.0 8.9938 
lcp 1702.0 6.8228 
rcp 1632.0 6.1670 
rcp 1642.0 6.1920 
rcp 1652.0 7.6162 
rcp 1662.0 9.0776 
rcp 1682.0 5.3814 
rcp 1692.0 6.5397 
rcp 1702.0 6.5355 
* 
*tcal table ends with end_tcal_table record 
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* 
end_tcal_table 
* 
* Trec - receiver temperature, degrees K 
* 
* if value is zero, no opacity corrections are used 
* 
 0.0 
* 
* Spillover table 
* 
* format: 
* elevation temperature 
* where: 
*  elevation is angular degrees above horizon 
*  temperature is Kelvin degrees of spillover noise 
* 
*spillover table ends with end_spillover_table record 
* 
end_spillover_table 
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Appendix 3: The important procedures in the ACQUIR.PRC file 
 
 
define  kill          05068000323 
“ Stopping ACQUIR…” 
sy=brk aquir & 
sy=brk fivpt & 
sy=brk onoff & 
log=station 
enddef 
 
define  initp         05067173207 
“ Initialising ACQUIR setup…” 
caloff 
“ FIVEPT setup…” 
fivept=azel,1,7,0.3,2,i1,1200 
“ ONOFF setup…” 
onoff=2,2,60,3.0,1200,allvc 
check= 
sy=go aquir & 
enddef 
 
define  acquire       05067173206 
“ Running ACQUIR” 
sy=run aquir /usr2/control/ctlpo.ctl $ & 
“ Setting LOG file name” 
log=acquir 
“ Setting CALRX file” 
calrx=calrx,fixed,1510.0,1510.0 
“ Logging System parameters – site specific” 
logpar 
enddef 
 
define  caloffnf      05067173218 
caloff 
sy=go onoff & 
!+1s 
sy=go onoff & 
enddef 
 
define  calonnf       05067173222 
calon 
sy=go onoff & 
!+1s 
sy=go onoff & 
enddef 
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Appendix 4: Example CTLPO.CTL file 
 
* CTLPO.CTL control file for AQUIR 
* 
*  Data formats: 
* 
*   Procedure names:  12 character Field System procedure or command 
*                     name. 
* 
*   Waits: minutes for corresponding procedure to complete 
*          maximum of 32767 
*          -2 => don't execute this procedure, its just a place holder 
*          -1 => self suspend after entering command, expect a GO,AQUIR 
*                in order to continue 
*          for FIVPT, ONOFF, and PEAKF waits: 
*           0 -> don't execute this command 
*          >0 -> wait that many minutes for FIVPT, ONOFF, or PEAKF program 
*                to complete, OF'ing them if they aren't done 
* 
*   Elevations: degrees  
*  
*   Source Names:  10 characters 
*  
*   Right Ascension: hhmmss.s  
*  
*   Declination: ddmmss  
*  
*   Epoch:  yyyy.y 
*  
*  First data record:  
*  
*   Setup procedure, Setup wait, Terminate Procedure, Terminate wait,  
*  
*                    Upper elevation Limit, ONSOURCE Wait, 
*                    Amount to lead source when calculating what's up  
* 
*         Sources outside elevation limits are considered 'down' 
* 
   INITP  -1 INITP -2 91 180 180 
* 
* Elevation mask for lower elvation limit: AZ EL AZ EL ... AZ 
* may contain multiple lines, an incomplete line ends with an EL 
* 
   0 2 360 
* 
*  Source records: 
* 
*    Name, R.A., Dec., Epoch, Preob procedure, Preob wait, 
* 
*          FIVPT wait, ONOFF wait, PEAKF wait, 
* 
*          Postob procedure, Postob Wait 
* 
*  The nominal maximum number of sources is 200, but it may vary. 
*  If there are too many in the file, the program will print a 
*  message with the current number. 
* 
*3c48       013741.30 +330935.1 2000 PREP    -2 -2 5  0 POSTP    -2 
*3c84       031948.16 +413042.1 2000 PREP    -2 -2 5  0 POSTP    -2 
*3c123      043355.20 +293414.0 1950 PREP    -2 -2 5  0 POSTP    10 
*3c147      053843.51 +494942.8 1950 PREP    -2 -2 5  0 POSTP    10 
*3c161      062710.10 -055304.8 2000 PREP    -2 -2 5  0 POSTP    5 
3c286      132849.66 +304558.7 1950 PREP    -2 -2 5  0 POSTP    10 
*3c295      141120.65 +521209.1 2000 PREP    -2 -2 5  0 POSTP    5 
*3c309.1    145907.58 +714019.9 2000 PREP    -2 -2 5  0 POSTP    -2 
*3c348      164840.00 +050435.0 1950 PREP    -2 -2 5  0 POSTP    -2 
*3c353      171753.30 -005550.0 1950 PREP    -2 -2 5  0 POSTP    -2 
*cygnusa    195928.40 +404402.0 2000 PREP    -2 -2 5  0 POSTP    15 
*virgoa     123049.42 +122328.0 2000 PREP    -2 -2 5  0 POSTP    -2 
*taurusa    053432.00 +220058.0 2000 PREP    -2 -2 5  0 POSTP    -2 
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Appendix 5: Example calibration setup procedure for Lovell telescope 
 
“ calibration setup for 5 ghz dual polarisation – station specific 
define  c5gdp         00000000000x 
“ setup frequencies across the band, 8 mhz spacing, 8 mhz bandwidth 
vc01=126.99,8.000 
vc02=126.99,8.000 
vc03=134.99,8.000 
vc04=134.99,8.000 
vc05=142.99,8.000 
vc06=142.99,8.000 
vc07=150.99,8.000 
vc08=150.99,8.000 
vc09=158.99,8.000 
vc10=158.99,8.000 
vc11=166.99,8.000 
vc12=166.99,8.000 
vc13=174.99,8.000 
vc14=174.99,8.000 
!+1s 
valarm 
“ select dual polarisation 
ifd=*,*,nor,nor 
“ set the effective LO – site specific 
lo=lo1,4840.00,usb,lcp,1.000 
lo=lo2,4840.00,usb,rcp,1.000 
“ local commands for local oscillators and receiver/telescope settings – site specific 
jbtel=1 
jbrx=1 
band=hi 
aglos=a1,298.8,-3.0 
jblos=452.2,120.0,38.0 
“ make sure cal is off and offsets are set – site specific 
caloff 
initoff 
“ setup a standard set of patches etc. 
patch=lo1,1l,3l,5l,7l,9l,11l,13l 
patch=lo2,2l,4l,6l,8l,10l,12l,14l 
initoff 
caloff 
pcalform=1u,1,8,0 
pcalform=2u,1,8,0 
pcalform=3u,1,8,0 
pcalform=4u,1,8,0 
pcalform=5u,1,8,0 
pcalform=6u,1,8,0 
pcalform=7u,1,8,0 
pcalform=8u,1,8,0 
pcalform=9u,1,8,0 
pcalform=au,1,8,0 
pcalform=bu,1,8,0 
pcalform=cu,1,8,0 
pcalform=du,1,8,0 
tapeform=  1,-319,  2,  31,  3,-271,  4,  79,  5,-223,  6, 127 
tapeform=  7,-175,  8, 175,  9,-127, 10, 223, 11, -79, 12, 271 
tapeform= 13, -31, 14, 319 
form=m,16.000,1:4 
tracks=v0,v1,v2,v3,v4,v5,v6,v7 
trackform=2,2us,6,2um,10,1us,14,1um,18,4us,22,4um,26,3us,30,3um 
trackform=3,6us,7,6um,11,5us,15,5um,19,8us,23,8um,27,7us,31,7um 
trackform=4,10us,8,10um,12,9us,16,9um,20,12us,24,12um,28,11us,32,11um 
trackform=5,14us,9,14um,13,13us,17,13um 
pcald 
tpicd 
enddef 
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Appendix 6: Standard FLUX.CTL file 
 
* flux.ctl - source flux control file 
* 
* source records: 
* 
* originally from John Conway based on (Casa, Cygnusa, TauA) from Baars et al 
* 1977, AA, 61, 99 and (others) Ott et al 1994, AA 284, 331, see sflux.f 
* subroutine, WEH 020813 
* 
* min freq on L band sources decreased to 500 per John Conway, WEH 0209xx 
* 
*               freq MHz  ---- flux 10** ----   "     FS 
* source  type  min  max  log   log(f) 2log(f) size  model 
   3c48     c   500 23780 2.465 -0.004 -0.1251   1.5 gauss 100    1s 
   3c123    c   500 23780 2.525  0.246 -0.1638  23   gauss 100   23s 5s 
   3c147    c   500 23780 2.806 -0.140 -0.1031   1   gauss 100    1s 
   3c161    c   500 10550 1.250  0.726 -0.2286   3   gauss 100    3s 
   3c218    c   500 10550 4.729 -1.025  0.0130  47   gauss 100   47s 14s 
   3c227    c   500  5000 6.757 -2.801  0.2969 200   gauss 100  200s 50s 
   3c249.1  c   500  5000 2.537 -0.565 -0.0404  15   gauss 100   15s 
* virgo structure guessed from FS manuals, WEH 0208xx 
   virgoa   c   500  2520 4.484 -0.603 -0.0280 200   gauss  80.8 40s 20s 19.2 10m 10m 
   virgoa   c  2520 10550 4.484 -0.603 -0.0280 200   gauss  97.3 40s 20s  2.7 10m 10m 
   3c286    c   500 43200 0.956  0.584 -0.1644   1.5 gauss 100    1s 
   3c295    c   500 32000 1.490  0.756 -0.2545   5   gauss 100    5s  1s 
* changed to "p" per Alex Kraus, WEH 020814 
   3c309.1  p   500 32000 2.617 -0.437 -0.0373   1.5 gauss 100  1.5s 1.5s 
   3c348    c   500 10550 3.852 -0.361 -0.1053 170   gauss 100  170s  25s 
   3c353    c   500 10550 3.148 -0.157 -0.0911 210   gauss 100  210s  60s 
   cygnusa  c    20  2000 4.695  0.085 -0.178  115   2pts  115s 
   cygnusa  c  2000 31000 7.161 -1.244  0.0    115   2pts  115s 
   taurusa  c   500 35000 3.915 -0.299  0.0    300   gauss 100 4.2m 2.6m 
* 
*  Flux of ngc7027 scaled by -0.5% per year (from Ott et al 1994) to  
*  epoch 13th Oct 2003 gives a flux density reduction to  93.7%  
*  of the 1990 level. John Conway 030205 
* 
   ngc7027  c 10550 43200 1.2937 -0.134  0       10   gauss 100 7s   10s 
* 
*  Flux density of DR21 at K band taken from Ott et al (1994) 
*  Ott et al 1994. John Conway 030205 
* 
   dr21     c 21000 24000 1.231  0.000  0.0     20  gauss  100 20s  20s  
* 
* casa is special name with flux decreasing from 1980.0 
* 
   casa     p   300 31000 5.745 -0.770  0       240  disk  4m 
* 
* the following points added from FS Manual WEH 0208xx 
* 
   3c380    p  2020  2520 1.041  0      0         1  gauss 100 1s 
   3c380    p  8080  9080 0.716  0      0         1  gauss 100 1s 
   3c391    p  2020  2520 1.204  0      0       270  gauss 100 4.5m 
   3c391    p  8080  9080 0.875  0      0       270  gauss 100 4.5m 
   0521m365 p  2020  2520 1.130  0      0        15  gauss 100 15s 
   0521m365 p  8080  9080 0.740  0      0        15  gauss 100 15s 
   sun      p  2020  2520 5.60206 0      0     1872  disk  0.52d 
   sun      p  8080  9080 6.39794 0      0     1872  disk  0.52d 
   moon     p  2020  2520 3.35218 0      0     1872  disk  0.52d 
   moon     p  8080  9080 4.49136 0      0     1872  disk  0.52d 
   oriona   p  2020  2520 2.64345 0      0      240  gauss 100 4m 
   oriona   p  8080  9080 2.53147 0      0      240  gauss 100 4m 
* 
*3c84 from DBS flux tabe, note source is variable, WEH 020916 
* 
   3c84     p  2020  2520 1.60205 0      0        1  gauss 100 1s   
   3c84     p  8080  9080 1.69987 0      0        1  gauss 100 1s   
* 
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Appendix 7: Example of one cycle from an AQUIR log file 
 
 
2004.047.16:34:49.10;Log Opened: Mark IV Field System Version 9.6.9 
2004.047.16:34:49.10;location,JB-LVL  ,2.31,53.23,83.0 
2004.047.16:34:49.10;horizon1,0.,20.,360. 
2004.047.16:34:49.11;antenna,76.0,15.0,10.0,-85.0,330.0,1.0,90.0,azel 
2004.047.16:34:49.11;equip,mk4,mk4,none,mk4,500.10,3,a/d,102,60,20,none,41 
2004.047.16:34:49.11;drivem11,330,270,yes 
2004.047.16:34:49.11;drivem12,100 
2004.047.16:34:49.11;head10,all,all,all,odd,adaptive,no,5.0000,1 
2004.047.16:34:49.11;head11,311.5,29.6,-9.4,326.7,31.2,12.8,155.62,155.62 
2004.047.16:34:49.11;head12,376.1,35.4,-129.6,308.4,28.6,26.3,154.07,154.07 
2004.047.16:34:49.11;time,0.000,0.000,ntp 
2004.047.16:34:49.11;flagr,-100 
2004.047.16:34:49.11/calrx/calrx,fixed,1510.00,1510.00 
2004.047.16:34:49.11&logpar/" log the current receiver/antenna settings 
2004.047.16:34:49.11&logpar/" change mrlos to aglos pb 040212 
2004.047.16:34:49.12&logpar/source 
2004.047.16:34:49.12&logpar/jbtel 
2004.047.16:34:49.12&logpar/jbrx 
2004.047.16:34:49.12&logpar/jblos 
2004.047.16:34:49.12&logpar/aglos 
2004.047.16:34:49.12&logpar/band 
2004.047.16:34:49.12&logpar/filtr 
2004.047.16:34:49.12&logpar/lo 
2004.047.16:34:49.12&logpar/poff 
2004.047.16:34:49.12&logpar/atten 
2004.047.16:34:49.12&logpar/track 
2004.047.16:34:49.12&logpar/azeloff 
2004.047.16:34:49.12&logpar/vread 
2004.047.16:34:49.12/source/3c161,062710.100,-055304.80,2000.0000,,062722.488,-055315.87,2004.1284 
2004.047.16:34:49.13/jbtel/1,off,2,off,3,off,4,off,5,off,6,off,7,off,8,off,9,off 
2004.047.16:34:49.13/jbrx/1,1.6GHz,1,1.6GHz 
2004.047.16:34:49.13/jblos/452.20,120.00,38.00 
2004.047.16:34:49.13/aglos/a1,298.800,-3.0,a2,0.000,0.0,a3,0.000,0.0 
2004.047.16:34:49.14/band/hi 
2004.047.16:34:49.14/filtr/BYP 
2004.047.16:34:49.14/lo/lo1,1510,usb,lcp,1,0 
2004.047.16:34:49.14/lo/lo2,1510,usb,rcp,1,0 
2004.047.16:34:49.14/poff/off 
2004.047.16:34:49.15/atten/25,25,25,25 
2004.047.16:34:49.25#antcn#tr/Lovell,VLBI-FS,062710.1,-5.88,J2000,0.0001,0.0007, 0.0200,-0.0010 
2004.047.16:34:49.25#antcn#tr/Lovell,VLBI-FS,114.33,10.06,J2000,0.0001,0.0007, 0.0200,-0.0010 
2004.047.16:34:49.25#antcn#rx/Lovell,5GHz,Low,452.20,120.0,38.0,25,25 
2004.047.16:34:49.25/azeloff/0.02000,-0.00100 
2004.047.16:34:49.25&vread/vc01 
2004.047.16:34:49.25&vread/vc02 
2004.047.16:34:49.25&vread/vc03 
2004.047.16:34:49.26&vread/vc04 
2004.047.16:34:49.26&vread/vc05 
2004.047.16:34:49.26&vread/vc06 
2004.047.16:34:49.26&vread/vc07 
2004.047.16:34:49.26&vread/vc08 
2004.047.16:34:49.26&vread/vc09 
2004.047.16:34:49.26&vread/vc10 
2004.047.16:34:49.26&vread/vc11 
2004.047.16:34:49.26&vread/vc12 
2004.047.16:34:49.26&vread/vc13 
2004.047.16:34:49.26&vread/vc14 
2004.047.16:34:49.33/vc01/120.99,2.000,u,10,10,rem,lock,6528 
2004.047.16:34:49.40/vc02/120.99,2.000,u,10,10,rem,lock,3565 
2004.047.16:34:49.47/vc03/130.99,2.000,u,10,10,rem,lock,6123 
2004.047.16:34:49.54/vc04/130.99,2.000,u,10,10,rem,lock,4719 
2004.047.16:34:49.61/vc05/140.99,2.000,u,10,10,rem,lock,8587 
2004.047.16:34:49.68/vc06/140.99,2.000,u,10,10,rem,lock,7680 
2004.047.16:34:49.75/vc07/150.99,2.000,u,10,10,rem,lock,5653 
2004.047.16:34:49.82/vc08/150.99,2.000,u,10,10,rem,lock,9296 
2004.047.16:34:49.89/vc09/160.99,2.000,u,10,10,rem,lock,6024 
2004.047.16:34:49.96/vc10/160.99,2.000,u,10,10,rem,lock,6025 
2004.047.16:34:50.03/vc11/170.99,2.000,u,10,10,rem,lock,4107 
2004.047.16:34:50.10/vc12/170.99,2.000,u,10,10,rem,lock,7480 
2004.047.16:34:50.17/vc13/180.99,2.000,u,10,10,rem,lock,7794 
2004.047.16:34:50.24/vc14/180.99,2.000,u,10,10,rem,lock,8808 
2004.047.16:34:50.24;initp 
2004.047.16:34:50.24&initp/caloff 
2004.047.16:34:50.24&initp/fivept=azel,1,7,0.3,2,i1,1200 
2004.047.16:34:50.24&initp/onoff=2,2,60,5.0,1200,allvc 
2004.047.16:34:50.24&initp/check= 
2004.047.16:34:50.24&initp/sy=go aquir & 
2004.047.16:34:50.24&caloff/caloffrd 
2004.047.16:34:50.25&caloffrd/"turn off cal diode.. 
2004.047.16:34:50.25&caloffrd/hpib=rd,m4 
2004.047.16:34:50.29;3c161 
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2004.047.16:34:50.29&3c161/source=3c161,062710.10,-055304.8,2000. 
2004.047.16:34:50.35/ack 
2004.047.16:34:52.29;onoff 
2004.047.16:34:52.29#onoff#    De    Center  TCal    Flux    DPFU     Gain    Product   LO    T   FWHM 
2004.047.16:34:52.29#onoff#APR 1u   1631.99 9.000    16.7  1.200000 0.83418  1.001014 1510.00 c 0.16896 
2004.047.16:34:52.29#onoff#APR 2u   1631.99 10.00    16.7  1.200000 0.83418  1.001014 1510.00 c 0.16896 
2004.047.16:34:52.30#onoff#APR 3u   1641.99 9.000    16.6  1.200000 0.83418  1.001014 1510.00 c 0.16793 
2004.047.16:34:52.30#onoff#APR 4u   1641.99 10.00    16.6  1.200000 0.83418  1.001014 1510.00 c 0.16793 
2004.047.16:34:52.30#onoff#APR 5u   1651.99 9.000    16.6  1.200000 0.83418  1.001014 1510.00 c 0.16691 
2004.047.16:34:52.30#onoff#APR 6u   1651.99 10.00    16.6  1.200000 0.83418  1.001014 1510.00 c 0.16691 
2004.047.16:34:52.30#onoff#APR 7u   1661.99 9.000    16.5  1.200000 0.83418  1.001014 1510.00 c 0.16591 
2004.047.16:34:52.30#onoff#APR 8u   1661.99 10.00    16.5  1.200000 0.83418  1.001014 1510.00 c 0.16591 
2004.047.16:34:52.30#onoff#APR 9u   1671.99 9.000    16.4  1.200000 0.83418  1.001014 1510.00 c 0.16491 
2004.047.16:34:52.30#onoff#APR au   1671.99 10.00    16.4  1.200000 0.83418  1.001014 1510.00 c 0.16491 
2004.047.16:34:52.30#onoff#APR bu   1681.99 9.000    16.3  1.200000 0.83418  1.001014 1510.00 c 0.16393 
2004.047.16:34:52.30#onoff#APR cu   1681.99 10.00    16.3  1.200000 0.83418  1.001014 1510.00 c 0.16393 
2004.047.16:34:52.30#onoff#APR du   1691.99 9.000    16.3  1.200000 0.83418  1.001014 1510.00 c 0.16296 
2004.047.16:34:52.30#onoff#APR eu   1691.99 10.00    16.3  1.200000 0.83418  1.001014 1510.00 c 0.16296 
2004.047.16:34:52.30;caloffnf 
2004.047.16:34:52.30&caloffnf/caloff 
2004.047.16:34:52.31&caloffnf/sy=go onoff & 
2004.047.16:34:52.31&caloffnf/!+1s 
2004.047.16:34:52.31&caloffnf/sy=go onoff & 
2004.047.16:34:52.41#onoff#ORIG 59692.3   0.00000   0.00000   0.02000  -0.00100   0.00000   0.00000 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 1u   6531.5      2.1 2u   3563.0      2.8 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 3u   6126.0      4.2 4u   4729.5      0.7 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 5u   8582.5     10.6 6u   7672.5      4.9 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 7u   5650.0      4.2 8u   9291.5      9.2 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 9u   5990.5      9.2 au   6003.0     14.1 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 bu   4108.0      2.8 cu   7479.5      2.1 
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 du   7805.5      2.1 eu   8793.5      7.8 
2004.047.16:34:56.34;calonnf 
2004.047.16:34:56.35&calonnf/calon 
2004.047.16:34:56.35&calonnf/sy=go onoff & 
2004.047.16:34:56.35&calonnf/!+1s 
2004.047.16:34:56.35&calonnf/sy=go onoff & 
2004.047.16:34:56.35&calon/calonrd 
2004.047.16:34:56.36&calonrd/"turn on cal diode.. 
2004.047.16:34:56.36&calonrd/hpib=rd,m3 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 1u   7253.5     12.0 2u   3930.0      2.8 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 3u   6443.5      4.9 4u   5037.5      0.7 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 5u   9403.0     12.7 6u   8199.0     14.1 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 7u   6348.5     17.7 8u  10249.0     21.2 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 9u   6421.5      3.5 au   6357.5      2.1 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 bu   4405.5      3.5 cu   8130.5     24.7 
2004.047.16:35:00.33#onoff#ONSC     7.3   0.00000   0.00000 du   8941.5     10.6 eu   9648.0     24.0 
2004.047.16:35:07.31#ancom#flagr/antenna,off-source 
2004.047.16:35:20.25#ancom#flagr/antenna,source re-acquired 
2004.047.16:35:24.16#onoff#OFFC    31.1   0.85802   0.00000 1u   5852.5      4.9 2u   3196.0      1.4 
2004.047.16:35:24.17#onoff#OFFC    31.1   0.85802   0.00000 3u   5748.0      1.4 4u   4382.0      1.4 
2004.047.16:35:24.19#onoff#OFFC    31.1   0.85802   0.00000 5u   7606.5      7.8 6u   7012.0      2.8 
2004.047.16:35:24.20#onoff#OFFC    31.1   0.85802   0.00000 7u   5042.5      2.1 8u   8650.5      2.1 
2004.047.16:35:24.22#onoff#OFFC    31.1   0.85802   0.00000 9u   5076.0      0.0 au   5161.5     12.0 
2004.047.16:35:24.23#onoff#OFFC    31.1   0.85802   0.00000 bu   3598.5      0.7 cu   6317.0      4.2 
2004.047.16:35:24.25#onoff#OFFC    31.1   0.85802   0.00000 du   7154.5     13.4 eu   7732.5      4.9 
2004.047.16:35:24.27;caloffnf 
2004.047.16:35:29.24#onoff#OFFS    36.2   0.85802   0.00000 1u   5080.5      0.7 2u   2814.0      0.0 
2004.047.16:35:29.25#onoff#OFFS    36.2   0.85802   0.00000 3u   5414.0      2.8 4u   4007.5      4.9 
2004.047.16:35:29.27#onoff#OFFS    36.2   0.85802   0.00000 5u   6742.0      1.4 6u   6461.5      2.1 
2004.047.16:35:29.28#onoff#OFFS    36.2   0.85802   0.00000 7u   4304.5      2.1 8u   7657.5      4.9 
2004.047.16:35:29.30#onoff#OFFS    36.2   0.85802   0.00000 9u   4574.5      0.7 au   4745.0      7.1 
2004.047.16:35:29.31#onoff#OFFS    36.2   0.85802   0.00000 bu   3281.5      2.1 cu   5638.5      3.5 
2004.047.16:35:29.33#onoff#OFFS    36.2   0.85802   0.00000 du   5935.5      6.4 eu   6775.5     12.0 
2004.047.16:35:33.31#onoff#ZERO    40.3   0.85802   0.00000 1u   1330.5      0.7 2u    917.0      0.0 
2004.047.16:35:33.32#onoff#ZERO    40.3   0.85802   0.00000 3u   3137.0      0.0 4u   1765.0      0.0 
2004.047.16:35:33.34#onoff#ZERO    40.3   0.85802   0.00000 5u   1626.5      0.7 6u   3194.5      0.7 
2004.047.16:35:33.35#onoff#ZERO    40.3   0.85802   0.00000 7u    776.0      0.0 8u   3419.5      0.7 
2004.047.16:35:33.37#onoff#ZERO    40.3   0.85802   0.00000 9u    956.5      0.7 au   1781.5      0.7 
2004.047.16:35:33.38#onoff#ZERO    40.3   0.85802   0.00000 bu   1150.0      0.0 cu    954.0      0.0 
2004.047.16:35:33.40#onoff#ZERO    40.3   0.85802   0.00000 du   1032.5      0.7 eu   2029.5      0.7 
2004.047.16:35:40.31#ancom#flagr/antenna,off-source 
2004.047.16:35:53.25#ancom#flagr/antenna,source re-acquired 
2004.047.16:35:57.16#onoff#ONSO    64.1   0.00000   0.00000 1u   6530.0      2.8 2u   3568.0      4.2 
2004.047.16:35:57.17#onoff#ONSO    64.1   0.00000   0.00000 3u   6326.0      4.2 4u   4707.5      0.7 
2004.047.16:35:57.19#onoff#ONSO    64.1   0.00000   0.00000 5u   8583.0      1.4 6u   7690.0      2.8 
2004.047.16:35:57.20#onoff#ONSO    64.1   0.00000   0.00000 7u   5658.0      1.4 8u   9325.0      5.7 
2004.047.16:35:57.22#onoff#ONSO    64.1   0.00000   0.00000 9u   5927.0      4.2 au   5945.0      1.4 
2004.047.16:35:57.24#onoff#ONSO    64.1   0.00000   0.00000 bu   4110.5      2.1 cu   7499.0      2.8 
2004.047.16:35:57.25#onoff#ONSO    64.1   0.00000   0.00000 du   7637.5      0.7 eu   8764.0     14.1 
2004.047.16:35:57.27;calonnf 
2004.047.16:36:01.22#onoff#ONSC    68.2   0.00000   0.00000 1u   7266.0      5.7 2u   3941.0      2.8 
2004.047.16:36:01.23#onoff#ONSC    68.2   0.00000   0.00000 3u   6644.5      2.1 4u   5024.5      6.4 
2004.047.16:36:01.25#onoff#ONSC    68.2   0.00000   0.00000 5u   9417.0     14.1 6u   8225.0      5.7 
2004.047.16:36:01.26#onoff#ONSC    68.2   0.00000   0.00000 7u   6364.0      8.5 8u  10283.5     12.0 
2004.047.16:36:01.28#onoff#ONSC    68.2   0.00000   0.00000 9u   6385.0      1.4 au   6317.5      6.4 
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2004.047.16:36:01.29#onoff#ONSC    68.2   0.00000   0.00000 bu   4416.0      5.7 cu   8159.0     11.3 
2004.047.16:36:01.31#onoff#ONSC    68.2   0.00000   0.00000 du   8772.0     14.1 eu   9591.0     11.3 
2004.047.16:36:09.31#ancom#flagr/antenna,off-source 
2004.047.16:36:22.25#ancom#flagr/antenna,source re-acquired 
2004.047.16:36:26.18#onoff#OFFC    93.1  -0.85802  -0.00000 1u   5836.0      1.4 2u   3188.5      0.7 
2004.047.16:36:26.19#onoff#OFFC    93.1  -0.85802  -0.00000 3u   5661.0      1.4 4u   4547.0     18.4 
2004.047.16:36:26.21#onoff#OFFC    93.1  -0.85802  -0.00000 5u   7591.5      7.8 6u   7003.5      2.1 
2004.047.16:36:26.22#onoff#OFFC    93.1  -0.85802  -0.00000 7u   5031.0      4.2 8u   8652.0      1.4 
2004.047.16:36:26.24#onoff#OFFC    93.1  -0.85802  -0.00000 9u   5048.5     19.1 au   5130.5      3.5 
2004.047.16:36:26.25#onoff#OFFC    93.1  -0.85802  -0.00000 bu   3594.0      0.0 cu   6311.0      2.8 
2004.047.16:36:26.27#onoff#OFFC    93.1  -0.85802  -0.00000 du   7247.5     26.2 eu   8187.5     91.2 
2004.047.16:36:26.28;caloffnf 
2004.047.16:36:30.24#onoff#OFFS    97.2  -0.85802  -0.00000 1u   5068.0      1.4 2u   2803.5      2.1 
2004.047.16:36:30.25#onoff#OFFS    97.2  -0.85802  -0.00000 3u   5363.0      1.4 4u   4159.0      8.5 
2004.047.16:36:30.27#onoff#OFFS    97.2  -0.85802  -0.00000 5u   6725.0      0.0 6u   6452.0      0.0 
2004.047.16:36:30.28#onoff#OFFS    97.2  -0.85802  -0.00000 7u   4293.0      2.8 8u   7655.0      1.4 
2004.047.16:36:30.30#onoff#OFFS    97.2  -0.85802  -0.00000 9u   4527.5      0.7 au   4749.0      4.2 
2004.047.16:36:30.31#onoff#OFFS    97.2  -0.85802  -0.00000 bu   3279.0      2.8 cu   5624.0      1.4 
2004.047.16:36:30.33#onoff#OFFS    97.2  -0.85802  -0.00000 du   5996.5     17.7 eu   7539.0     94.8 
2004.047.16:36:37.31#ancom#flagr/antenna,off-source 
2004.047.16:36:50.26#ancom#flagr/antenna,source re-acquired 
2004.047.16:36:54.18#onoff#ONSO   121.1   0.00000   0.00000 1u   6521.0      5.7 2u   3563.0      1.4 
2004.047.16:36:54.19#onoff#ONSO   121.1   0.00000   0.00000 3u   6126.5      4.9 4u   4751.5      0.7 
2004.047.16:36:54.21#onoff#ONSO   121.1   0.00000   0.00000 5u   8580.5      3.5 6u   7687.5      3.5 
2004.047.16:36:54.22#onoff#ONSO   121.1   0.00000   0.00000 7u   5647.0      1.4 8u   9308.5      0.7 
2004.047.16:36:54.24#onoff#ONSO   121.1   0.00000   0.00000 9u   6020.5     30.4 au   5975.5     19.1 
2004.047.16:36:54.25#onoff#ONSO   121.1   0.00000   0.00000 bu   4107.0      0.0 cu   7488.0      4.2 
2004.047.16:36:54.27#onoff#ONSO   121.1   0.00000   0.00000 du   7867.0      1.4 eu   8779.0      4.2 
2004.047.16:36:54.28;calonnf 
2004.047.16:36:58.24#onoff#ONSC   125.2   0.00000   0.00000 1u   7247.5      6.4 2u   3930.5      6.4 
2004.047.16:36:58.25#onoff#ONSC   125.2   0.00000   0.00000 3u   6427.0      2.8 4u   5085.5     10.6 
2004.047.16:36:58.27#onoff#ONSC   125.2   0.00000   0.00000 5u   9411.5      4.9 6u   8211.0      1.4 
2004.047.16:36:58.28#onoff#ONSC   125.2   0.00000   0.00000 7u   6359.5     12.0 8u  10266.0     15.6 
2004.047.16:36:58.30#onoff#ONSC   125.2   0.00000   0.00000 9u   6443.0     15.6 au   6331.0      0.0 
2004.047.16:36:58.31#onoff#ONSC   125.2   0.00000   0.00000 bu   4408.5      2.1 cu   8146.5     16.3 
2004.047.16:36:58.33#onoff#ONSC   125.2   0.00000   0.00000 du   8976.5      2.1 eu   9656.5     24.7 
2004.047.16:36:58.34;caloffnf 
2004.047.16:36:58.39#onoff#SIG                       1u                0.02  0.90    0.4   0.144 0.145  0.02 
2004.047.16:36:58.41#onoff#SIG                       2u                0.03  1.34    0.6   0.144 0.144  0.01 
2004.047.16:36:58.43#onoff#SIG                       3u                0.44 15.02    5.5   1.504 1.506  0.17 
2004.047.16:36:58.44#onoff#SIG                       4u                0.36 27.24   12.7   3.217 3.220  0.32 
2004.047.16:36:58.46#onoff#SIG                       5u                0.02  1.08    0.4   0.111 0.111  0.01 
2004.047.16:36:58.46#onoff#SIG                       6u                0.03  1.06    0.4   0.104 0.104  0.01 
2004.047.16:36:58.46#onoff#SIG                       7u                0.02  0.74    0.4   0.112 0.112  0.01 
2004.047.16:36:58.46#onoff#SIG                       8u                0.02  0.10    0.3   0.072 0.072  0.01 
2004.047.16:36:58.46#onoff#SIG                       9u                0.10  5.28    1.7   0.360 0.360  0.04 
2004.047.16:36:58.46#onoff#SIG                       au                0.08  4.13    0.7   0.307 0.308  0.03 
2004.047.16:36:58.46#onoff#SIG                       bu                0.02  0.72    0.1   0.067 0.067  0.01 
2004.047.16:36:58.46#onoff#SIG                       cu                0.02  1.25    0.4   0.072 0.072  0.01 
2004.047.16:36:58.46#onoff#SIG                       du                0.11  2.48    2.5   0.797 0.798  0.09 
2004.047.16:36:58.46#onoff#SIG                       eu                0.83 55.89   22.5   4.230 4.234  0.42 
2004.047.16:36:58.46#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 1u 1 l   1631.99 0.9457 43.76   43.0   8.852 0.9846 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 2u 2 r   1631.99 0.9626 49.33   41.8   8.476 0.8485 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 3u 1 l   1641.99 0.9879 64.12   46.6   6.534 0.7268 
2004.047.16:36:58.46#onoff#VAL 3c161      114.3 10.1 4u 2 r   1641.99 0.8385 60.81   59.7   9.812 0.9822 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 5u 1 l   1651.99 0.9573 53.11   45.7   7.752 0.8622 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 6u 2 r   1651.99 0.9589 59.21   44.0   7.438 0.7445 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 7u 1 l   1661.99 0.9562 42.96   42.9   8.991 1.0000 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 8u 2 r   1661.99 0.9626 42.58   42.3   9.927 0.9937 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 9u 1 l   1671.99 0.8551 63.28   41.3   5.873 0.6532 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 au 2 r   1671.99 0.9043 74.32   39.6   5.334 0.5339 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 bu 1 l   1681.99 0.9541 60.67   42.0   6.233 0.6932 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 cu 2 r   1681.99 0.9616 68.51   41.1   6.004 0.6010 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 du 1 l   1691.99 0.9123 35.95   44.5  11.134 1.2383 
2004.047.16:36:58.47#onoff#VAL 3c161      114.3 10.1 eu 2 r   1691.99 1.0626 63.88   51.4   8.051 0.8059 
2004.047.16:36:58.47#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 
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1. Introduction 
 
This document is a short "how to" guide to GNPLT main features covered by the Antenna Gain 
Calibration class at the IVS TOW. This is not meant to be a complete user manual. 
 
GNPLT is a Tcl/Tk program distributed together with the Field System for examining and analyzing the 
accuracy of the amplitude calibration of a telescope. A good calibration depends on how accurately, 
the TCal(Jy) is predicted thanks to the combination of gain curve and TCal(K) versus frequency. 
These calibration parameters are stored in the control .rxg files - GNPLT allows updating this 
information starting from a Field System log file containing ONOFF data. 
 
2. Plotted Quantities 
 
GNPLT is mostly focused on calibration parameters but it is also able to plot many others versus 
variables like frequency, elevation, azimuth, airmass and time. All these quantities could be split into 
two groups: measured quantities and derived quantities. 
 
2.1 Calibration parameters 
 
Calibration parameters are loaded from .rxg files at start. In order to prevent modifications by accident, 
GNPLT copies these files into working files. DPFU, gain curve polynomial, TCal(K) belong to this 
group. While running GNPLT, these parameters are fitted and changed to new values that can be 
stored, again in working files. Before exiting GNPLT, the user can decide whether to update the 
calibration parameters into the .rxg file with the ones present in the current working file, or not. 
 
2.2 Measured Quantities 
 
When a log file is opened, GNPLT imports these quantities from ONOFF records (VAL). The most 
important ones are SEFD(Jy), TCal(Jy) and Gain Compression. These values never change during 
GNPLT sessions. TCal(K) and TCalRatio are also reported by ONOFF but they are recalculated by 
GNPLT every time that new calibration parameters are fitted. 
 
2.3 Derived Quantities 
 
Derived quantities are calculated by GNPLT from measured quantities and also from calibration 
parameters. Gain, for instance, is calculated by dividing the TCal(K) by the measured TCal(Jy). 
 
2.4 Description of Quantities 
 

I. TCal(K) - Noise calibration signal in Kelvin degrees. This calibration parameter is stored into 
.rxg files. 

II. TCal(Jy) - Noise calibration signal in Janskies. It's given by 
skysource

skyCal
source TPTP

TPTP
FJyTCal




)(  

where Fsource is the flux density of a known radio source. 
III. DPFU(K/Jy) - Degrees Per Flux Unit. This calibration parameter is the maximum height of the 

gain curve. 
IV. SEFD(Jy) - System Equivalent Flux Density, which is, in brief, the system temperature in 

Janskies. 
V. Gain Compression -This is obtained by calculating the ratio of variation in counts switching 

the cal on when on source to the change in counts when off source. This ratio should be 
close to one as much as possible. If this does not happen, any other measured parameters 
are likely to be unreliable. For instance, the presence of RFI could affect this value. 
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VI. TCalRatio - This is a derived quantity. It is the ratio of measured TCal(Jy) by ONOFF to the 
one predicted by calibration parameters. This provides an indication of how well your 
telescope is calibrated. 

VII. Trec(K) - Receiver temperature in Kelvin Degrees. 
VIII. Tspill(K) - The system temperature contribution due to spillover. 

IX. Airmass - Defined as )sin(
1

elevation . 

 
3. Starting GNPLT 
 
A main program composes this software: GNPLT, which is the GUI that displays all the data and 
permits all the user operations over them. GNPLT makes use of two other programs: GNDAT and 
GNFIT. 
 
GNDAT takes care of parsing the log file and extracting all the relevant data. GNFIT performs the 
curves fitting and returns the curve polynomial, the RMS, and the number of iterations needed. 
 
In order to start the program it is sufficient to run GNPLT. At the command prompt of your Field 
System machine type "gnplt". GNPLT can also accept two command line arguments, one is -r which 
forces the program to auto-replot every time the user makes selections on plot axes, the second one 
is the log file name. 
 
4. The 'File' menu 
 
4.1 Opening a log file 
 
The first method is the command line argument as described before. Another way to open a log file is 
to select the 'New' menu item. A window will open that lets you select the file name and location. If the 
file you selected is valid, GNPLT begins to parse the log by running GNDAT. When this process is 
completed successfully the status bar of the main window should say 'Ready'. During this stage all 
menus are also set up. 
 
4.2 Printing 
 
GNPLT is capable to print the plots in the encapsulated postscript format (eps). On the 'File' menu 
there is the 'Print' menu item that allows printing the current plot. A new window labeled 'print plot' will 
open; if you select 'printer' as destination, the 'lpr' command will be use to print the plot, if you choose 
'file' the output will be the file specified in the 'Filename' entry field. If no directory is specified, the 
current directory is used. 
 
5. Selecting the axes and plotting quantities 
 
Before you can plot anything, you have to choose the items for the X and Y axes. On the 'Items(X-
Axis)' menu you have five different options that are self-explaining: Time, Elevation, Frequency, 
Azimuth, and Airmass. The 'Items(Y-Axis)' menu consists of three sections. First, there are the 
standard quantities from the log file. Then, you have the 'Assumed Items' with all the information 
reported by the .rxg file. Finally, you have the 'Gain' cascade menu, which has four additional options 
that differ in how the gain is calculated. This section is a little bit more complicated and it will be 
discussed later. 
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6. Replotting 
 
When you have selected what is to be plotted you will have to replot. This could be done by either 
clicking the 'Replot' menu item on the 'Edit' menu or by pressing the 'r' key on your keyboard. The 
replot could also be performed automatically: if you start GNPLT with flag '-r' on the command line or if 
you select 'Yes' on the cascade menu 'Auto Replot' located on the 'Edit' menu, GNPLT will 
automatically replot every time you change the axes. 
 
7. Selecting sources and frequencies 
 
By default GNPLT plots all the observed frequencies and sources in the log file. This case is very 
rarely needed, so GNPLT allows you to select specific sources and frequencies. 
 
7.1 Source selection 
 
On the 'Select Source' cascaded menu located on the 'Edit' menu there are four items: 

I. 'All' - Select all the sources. 
II. 'All Calibrators' - Select all sources that are calibrators. 

III. 'All Calibrators & Pointing' - Select all calibrators and pointing sources. 
IV. 'None' - No sources at all. 

If you want to be more detailed, a sub menu for each source is added. This menu(s) lists all the times 
that the source was observed; by clicking these check buttons you can add/remove these scans from 
the plot. 
 
7.2 Polarization selection 
 
On the 'Edit' menu there are two cascade menus, one for the 'Left' polarization, one for the 'Right' 
polarization. On each of them there are three command buttons: 

I. 'All' - Select all frequencies for that polarization. 
II. 'No Left'/'No Right' - Deselect all frequencies for that polarization. 

III. 'No Left or Right' - Deselect all frequencies for both polarizations. 
Below the command buttons there is a variable number of buttons labeled with LO values; this number 
depends on how many LOs are present in your log file. Clicking one of them selects and deselects all 
the frequencies associated to that LO. Finally, you can find as many check buttons as the number of 
frequencies observed. These check buttons report also the mnemonic of the device/detector. With 
these widgets you can switch the associated frequency on and off. 
 
8. Highlighting 
 
8.1 Highlighting sources 
 
All the sources in the log file will be displayed as radio buttons on the 'Source' menu. There is also a 
radio button for 'All' sources. When you click on one of these radio buttons all the points for that 
source are highlighted (that means they are filled with black ink). In case you replot or select 'All' they 
turn white again. 
 
On the 'Source' menu there is also the cascade menu 'Select Display' that allows to control how the 
data points are displayed inside the plot: 

I. 'Points' - Data are displayed as circles. 
II. 'Letters' - Data are represented by a letter in the same position in which the points would 

normally be. 
III. 'Points and Letters' - This is the default; data are displayed as a combination of circles and 

letters. 
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It must be noted that just right of the plotting area there is a box, labeled 'Source Legend', indicating 
which source each letter is associated with. 
 
8.2 Highlighting frequencies 
 
The 'Frequencies' menu works just as the 'Source' menu. All the currently plotted frequencies are 
associated with a radio button. Clicking the radio button will highlight all the points with that frequency. 
 
9. Scaling 
 
The scaling functionalities are accessible through the 'Scaling' menu. This menu controls the 
conditions on which the limits of both the axes are set. The default is to let GNPLT choose the limits 
for you. 
 
9.1 Autoscaling 
 
There are two different types of autoscaling on the 'Scaling' menu. For both options GNPLT will set the 
axes limits depending on what the user has selected on the 'Edit' menu. If you choose to 'Autoscale 
Including Deleted', all points matching your selection will be used to calculate axes limits, on the 
contrary if you choose to 'Autoscale Not Including Deleted', all deleted (see section 10) points will be 
left out. 
 
9.2 Manual scaling 
 
The radio button 'Manual' on the 'Scaling' menu allows you to set axes limits. A new window, showing 
the current limits, will open. You are now enabled to change what you prefer and when the 'Ok' button 
is pressed the selected limits are used. Before applying these limits some checks are performed, so if 
you inserted bad values (i.e. the maximum is smaller than minimum) you'll get an error message on 
the status bar. You also might want to zoom an area, this can be done using the left mouse button and 
dragging a rectangle, the selected region will be displayed in more detail. 
 
10. Data editing 
 
Often, in order to obtain a good fitting and so a better accuracy for calibration parameters it is 
necessary to delete some points that are noisy. A deleted point is not included in the input data of the 
fitting routine. A point status is described by its color: 

I. White - the point is included, i.e. the point fits the user selection and is not deleted (clicked) 
II. Red - the point is deleted (see section 10.1) 

III. Black - the point is highlighted. 
IV. Blue - the point is selected but it is outside the plotting limits, it is drawn on the plot borders. 

Next to the plot there is the information box. This box reports information on how many points have 
been highlighted (see section 8.0), selected (points that are inside the user selection), included (points 
that are selected and not deleted) and finally on how many points are present in the log file. 
 
10.1 Mouse editing 
 
Moving the mouse cursor close to a point on the plot all the data related to that point are displayed on 
the right side of the main window, including time, frequency, polarization, etc. 
 
Clicking on a point turns it red, i.e. the point is deleted from calculations. If you want to throw away a 
group of points just draw a box with the right mouse button around them. If the 'Shift' key is pressed 
while deleting a point, all the observations that have the same time will be deleted. If you want to 
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restore a deleted point it is sufficient to click on it again. A group of points could be undeleted by 
dragging an area with the middle mouse button. 
 
10.2 Editing out the bad data 
 
As already discussed the Gain Compression could be a good indication on whether the data are 
reliable or not. The fastest way to discard the bad data based on Gain Compression is to click the 
"Delete points with bad GC" on 'Edit' menu. A window opens, where you can select the upper and 
lower thresholds, beyond which data are rejected. This operation is highly recommended before any 
further analysis. 
 
10.3 Deleting point outside plot 
 
If you want all points outside the current plot limits to be deleted, you can achieve this by the 'Delete 
points outside plot' on the 'Edit' menu. 
 
10.4 Undelete points 
 
Sometimes you may want to restore all previously deleted points and to display again the points 
outside the limits. This operation is particularly useful when the display, for some reason, doesn't quite 
respond to your request. The quickest way to do this is to use the command 'Undelete All For This 
Selection' on 'Edit' menu. The 'Undelete All Points in Log' command does the same except for the fact 
that it also clears all user selections done via the 'Edit' menu. 
 
11 Overview on amplitude calibration 
 
In order to get accurate calibration for VLBI you will need to tune DPFU or/and TCal(K) versus 
frequency. If the model given by the combination of both these parameters is not consistent, then the 
prediction of the TCal(Jy) will be different from the one measured by ONOFF using a source of known 
flux density. For VLBI purposes you could focus only one between DPFU and TCal(K), but ideally you 
should choose to tune both these parameters and to describe your system as close to reality as 
possible. 
 
Generally speaking you should update the parameter you are more doubtful about, i.e. the parameter 
that mostly differs from what you expect. 
 
12 Checking gain curve and DPFU 
 
The first step you need is to select the polarization and LO on 'Edit' menu (see section 7.2). Please 
notice that although left and right polarization share the same gain curve polynomial they have 
different DPFU. This means that once you fitted the gain curve for one polarization the other must 
share the same curve. 
 
The second step is to plot Gain versus elevation. The gain is a derived quantity and is calculated from 
TCal(Jy) in the log file and an assumed TCal(K). The 'Gain' drop down menu on 'Items(Y-axis)' menu 
gives three choices on where to obtain this TCal(K): 

I. 'TCal from working file' - This is the more common choice, the TCal will be read from the 
working file. 

II. 'TCal from user input' - A single value can be inserted manually and it will be the same for all 
the frequencies. 

III. 'Specify gain for elev. range' - The TCal(K) will be set to a value such that the gain will have a 
certain mean value over a range of elevations. 
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Last two choices were provided in order to allow the user to input data taken from external calibrations 
(for example from calculating the antenna gain from its area and efficiency). 
 
Having done these two operations the 'Tools' menu is now populated by the tools needed to fit a gain 
curve: 

I. 'Gain Curve in working file' - switching on/off this check button displays/removes the gain curve 
from working file (solid green line). 

II. 'Fitted Gain Curve' - switching on/off this check button displays/removes the fitted gain 
curve(dashed black line). The combination of these two commands is very useful to compare 
the old curve with the new one and decide whether to update the working file or not. 

III. 'Fit to' - This item is a cascade submenu where there are three different fitting options: 
a.  'New DPFU' - the existing gain curve in the .rxg working file will be used to calculate a 

new DPFU for the current polarization. 
b. 'Gain Curve and DPFU' - A dialog window will appear. In that box you will be able to 

select the degree of the curve polynomial and the type of the gain curve (ALTAZ or 
ELEV). The result is a new gain curve and DPFU for that polarization. 

c. 'Scale TCal(K) - This will cause the TCal(K) in the working file to be scaled by a factor. 
This factor is the average of the gain divided by DPFU times the gain curve, averaged 
over all the points. 

IV. 'Update Working File' - This will update the .rxg working file with the last fit. After the updating, 
the last fitted curve turns green since it is now the curve in the .rxg working file. 

The step-by-step check list you need to obtain gain curve and DPFU from your data, is: 
I. Open a log file. 

II. Delete bad data using Gain compression. 
III. Select source(s). 
IV. Select a polarization. 
V. Plot Gain(using TCal(K) from working file) versus elevation. 

VI. Delete noisy points. 
VII. Fit a new gain curve and DPFU. 

VIII. If you are satisfied, update the working file. 
IX. Select the other polarization. 
X. Replot. 

XI. Delete noisy points. 
XII. Fit for a new DPFU. 

XIII. If you are satisfied, update the working file. 
XIV. Done. Before exiting, remember to update the original .rxg file if you want to store new 

parameters definitively. 
 
12. Checking TCal(K) versus frequency 
 
Also in this case one polarization should be analyzed at a time. After plotting TCal(K) versus 
frequency you can use the options under the 'Tools' menu: 

I. 'TCal(K) curve in file' - switching on/off this check button displays/removes the TCal(K) curve 
from working file (solid green line). 

II. 'Fitted TCal(K) curve' - switching on/off this check button displays/removes the fitted gain 
curve(dashed black line). Basically these two commands work in the same way the buttons for 
the gain curve do. 

III. 'Fit for TCal(K)' - This item is a cascade submenu where there are two different options: 
a. 'Average at each freq.' - GNPLT will average the TCal(K) value at each frequency and 

then draw a line(dashed black line) between these points. 
b. 'Median at each freq.' - GNPLT will calculate the median(average of the two middle 

values) of the TCal(K) values at each frequency and then draw a line(dashed black 
line) between these points. 
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IV. 'Update working file' - This will update the .rxg working file with the last fitted TCal(K) table. 
After the updating, the last fitted curve turns green since it is now the curve in the .rxg working 
file. 

The step-by-step checklist, you need to obtain gain curve and DPFU from your data, is: 
I. Open a log file. 

II. Delete bad data using Gain compression. 
III. Select source(s). 
IV. Select a polarization. 
V. Plot TCal(K) versus frequency. 

VI. Delete noisy points. 
VII. Fit a new TCal(K) table for the current polarization. 

VIII. If you are satisfied, update the working file. 
IX. Select the other polarization. 
X. Replot. 

XI. Delete noisy points. 
XII. Fit a new TCal(K) table for the current polarization. 
XIII. If you are satisfied, update the working file. 
XIV. Done. Before exiting, remember to update the original .rxg file if you want to store new 

parameters definitively. 
 
13 Opacity corrected gain 
 
GNPLT allows you to correct your data for opacity (). This capability makes sense only if you are 
analyzing data acquired at frequencies greater than 8 GHz. In fact, doing an opacity correction at 4/5 
cm or higher will probably make your calibration worse. 
 
This feature will only be available if the receiver temperature Trec(K) is included in your .rxg file. The 
spillover table versus elevation should also be supplied. Anyway this last information is optional and it 
could be missing. In that case Tspill(el)=0 will be assumed by GNPLT. 
 

GNPLT make use of this formula: . For each data point the  

is found. The opacity corrected gain is then  times the uncorrected gain. In order to enable this 
feature the radio button 'Correct for opacities' should be clicked. This button is on 'Gain' cascade 
menu already described in section 12. The program will then prompt the user for the Tatm(K). The 
ambient temperature at the moment of the observation -15k is often used. A corrected gain curve is 
obtained by fitting in the same way as usual. The curve polynomial in the .rxg file will be marked by the 
tag 'opacity_corrected'. 
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13.1 Fitting for Trec(K) 
 
Opacity correction are clearly very dependant on having a good Trec(K). GNPLT allows you to check if 
the value of the assumed Trec(K) is consistent by comparing it with an estimation from your data. If 
you plot Tsys-Tspill versus airmass, the 'Tools' menu is set up with the commands you will need to fit 
a new Trec and to update working file, if needed: 

I. 'Mark Trec from working file' - This check button displays/removes the current Trec(K) marker. 
If the marker is off the plot limits, a message will appear on the status bar. 

II. 'Mark fitted Trec' - This check button displays/removes the last fitted Trec(K) marker. If there is 
no fitted Trec(K) a message will appear on the status bar. 

III. 'Fit for Trec' - You will be asked to insert the Tatm and a time interval over which the 
atmospheric opacity is supposed to be constant. Data from each time segment will be fitted by 

the curve ) , where 0 is the zenith opacity. If your data is 

collected during N hours and you choose a K hours interval then |N/K| curves are calculated 

1( 0 Airmass
atmrecspillsys eTTTT  
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IV. 'Recalculate Trec' - This command can be used to recalculate the weighted mean after some 
editing (i.e. Trecs could be deleted as normal data points). 

V. 'Update working file' - This will update the .rxg working file with computed Trec(K). 
 
14. Shortcut methods 
 
Under the 'Edit' menu you can find three shortcuts for plotting gain versus elevation, TCal(K) versus 
frequency and Tsys-Tspill versus airmass. These commands should speed up editing and selection 
but what is plotted is more restricted than if using the general method. For example, for gain versus 
elevation only a single frequency (detector) can be plotted and the needed TCal(K) is always taken 
from the working file. 
 
 


